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1) Legal Notices 
 

1.1) Copyright 
 
All material presented in this user's manual is subject to the copyright laws of the United 
States of America. 
 
Copyright © 2005 RW Automation, LLC - All rights reserved 
 
RW Automation, LLC reserves the right to make changes and improvements to its 
products and to this document without notification. 
 

1.2) License agreement 
 
The software executables and files packaged with the MV Tool application are intended 
for use as-is. Any alteration of the software is strictly forbidden without written 
permission of RW Automation, LLC. Any bundling, re-packing, or re-distribution of any 
of the software files included in the original MV Tool distribution file is strictly 
forbidden without written permission of RW Automation, LLC. 
 

1.3) Limited warranty 
 
RW AUTOMATION, LLC MAKE NO WARRANTIES, EXPRESS OR IMPLIED, 
AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF MERCHANTABILITY 
OR FITNESS FOR A PARTICULAR PURPOSE. RW AUTOMATION, LLC WILL 
NOT BE LIABLE FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, 
USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN 
IF ADVISED OF THE POSSIBILITY THEROF. 
 

1.4) Third-party trademarks 
 
“Microsoft” and “Microsoft Windows” are registered trademarks of Microsoft 
Corporation. 
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2) Introduction 
 
The MV Tool application was created to allow users to experience the features of the MV 
Lib machine vision library. When reading this document, it is helpful to refer to the MV 
Lib user’s guide in order to understand the functionality presented in the MV Tool 
application UI. 
 
 

2.1) Features 
 
MV Tool allows the user to access the following features of MV Lib: 
 

-Several image types to allow processing of images over wide dynamic ranges. 
-Image creation, copy, paste, load from disk, save to disk. 
-Image graphics and image generation. 
-Image algebra. 
-Image transforms, pixel mapping, contrast manipulation, geometric transforms. 
-Filters, low pass, high pass, order-statistic, generic sliding window. 
-2-D Fourier transforms. 
-Image morphology 
-Normalized correlation search. 
-Fiducial localization. 
-Image segmentation, connectivity, and watershed analysis. 
-Image projections. 
-Image statistics and scene angle finder. 

 
 

2.2) Installation 
 
The MV Tool application runs under Microsoft Windows 95/98/2000/XP operating 
systems. It is distributed as a single self-extracting setup executable file. Simply run the 
setup file and follow the instructions. The MV Tool application, along with this 
document, the MV Lib user’s guide, and an uninstall utility are all provided in the 
distribution file. 
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2.3) Running MV Tool 
 
When MV Tool is first started, a reduced menu is available to the user as shown in the 
screen shot below. This menu continues to be displayed until an image is loaded. Each 
image will be displayed in a child window within the MV tool application. 
 

 
 
As shown in the screen shot below, once any image is displayed, the full menu is made 
available to the user. With a few exceptions noted in later in this document, the user 
options will operate on the image that is selected (topmost child window). 
 

 
 
Regions of interest in an image may be "selected" by clicking the image and dragging the 
cursor over the image. A green rectangle will be updated real-time to display the region 
of the image selected by the user. 
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3) File menu 
 
This section describes the use of the options listed in the File menu. 
 
 

3.1) New 
 
When this option is selected, the user is presented with the following dialog: 
 

 
 
This dialog allows the user to generate an image using a variety of mathematical models. 
Refer to the “Image graphics” section of the MV Lib user’s guide for details on the types 
of images that can be generated. 
 
Once “OK” is pressed, an image will be generated using the chosen parameters and 
displayed in a new child window. 
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3.2) Duplicate 
 
A copy of the topmost (selected) image is made and is put into a new child window 
where it can be processed separately from the original image. 
 
 

3.3) Open 
 
A standard Open File dialog is presented to the user. The user may select a single image 
file or multiple image files to open. Each image file opened is put into its own child 
window within the MV Tool main window. 
 
MV Tool will use the “image I/O” functions of MV Lib to automatically determine the 
image file format (BMP, GIF, or MV). 
 
If MV Tool cannot determine the file format, the user is presented with the following 
dialog: 
 

 
 
This dialog allows users to import raw 8-bit images from other sources. 
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3.4) Close 
 
This will close the topmost child window. 
 
 

3.5) Save 
 
If the image path is already known, this option will save the image to the known path 
(overwriting the image that is already there, if any). If the path is not known, the option is 
ignored. 
 
 

3.6) Save as 
 
A standard Save File dialog is presented to the user. The user may select the file format 
(see MV Lib user’s guide) by selecting an option from the “save as type” drop box. 
Otherwise, the file extension is used to determine if the image will be written in BMP,  
GIF, or MV format. 
 
 

3.7) Print 
 
This option will print the image in the topmost child window. A standard Print dialog is 
presented to the user. The content of this dialog will be dictated by the print driver(s) 
installed on the PC. 
 
 

3.8) Print setup 
 
A standard Print Setup dialog is presented to the user. The content of this dialog will be 
dictated by the print driver(s) installed on the PC. 
 
 

3.9) Recent files 
 
The four most recently opened files are listed at the bottom of the menu. Selecting one of 
these will open the image file (if it still exists) and will display the image in a new child 
window. 
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3.10) Exit 
 
Selecting this option will cause the MV Tool application to stop running and close. 
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4) Edit menu 
 
This menu is used to allow the user to do some simple editing operations on images. 
 
 

4.1) Copy 
 
Before using this option, the user must first select the region of interest (or the whole 
image) of the topmost child window that is to be copied. 
 
The copy option will copy the selected region of the image to the clipboard, where it will 
be available to MV Tool and other applications. 
 
Note: regardless of the image type being copied, the image copied to the clipboard will be 
an 8-bit monochrome image. 
 
 

4.2) Paste 
 
Before using this option, the user must first select a region of interest (or the whole 
image) of the topmost child window in which the paste operation is to be applied. 
 
The paste option will copy the image from the clipboard to the selected region. If 
necessary, the clipboard data will be converted to the image type of the paste region. 
 
If the paste region is smaller than the clipboard image, only the upper-left part of the 
clipboard image is pasted into the region (as much as will fit). 
 
If the paste region is larger than the clipboard image, the clipboard image is pasted into 
the top-left corner of the paste region and the excess portion of the region is left as-is. 
 
 

4.3) Paste to new 
 
This operation will create a new child window of the same size as the image in the 
clipboard. The clipboard data is then pasted into the new image, completely filling it. 
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4.4) Select all 
 
This option will select the entire image of the topmost child window. A green rectangle 
representing the selected region will appear in the child window. 
 
 

4.5) Convert 
 
MV Lib supports images of several different types (resolutions), Refer to the MV Lib 
user’s manual for details of these image types. 
 
This option allows the user to convert the topmost child window into a different image 
type. 
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5) View Menu 
 
This menu is used to control the toolbar and status display. 
 
 

5.1) Toolbar 
 
The (dockable) toolbar may be enabled or disabled using this menu option. 
 

 
 
The toolbar options mirror the menu options (from left to right): new, open, save, cut (not 
supported), copy, paste, print, help. 
 
 

5.2) Status 
 
The status display may be enabled or disabled using this menu option. 
 

 
 
The status display at the bottom of the MV Tool window is used to display image 
coordinates and whether the user is in the region of interest selection mode or profile 
mode: 
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6) Transform menu 
 
Transforms are used to transform an image into another one. 
 
 

6.1) Scale 
 
Selecting this option makes the following dialog appear: 
 

 
 
The user may select to scale the images independently in X and Y, otherwise the X scale 
and Y scale edit boxes will maintain the same scaling factor and the resulting image will 
retain the aspect ratio of the original image. Refer to the MV Lib user’s guide for 
information regarding scaling factors and interpolation types. 
 
When OK is pressed, the image in the topmost child window is scaled per the parameters 
entered into the dialog box and the new scaled image replaces the original image in the 
child window. 
 
 

 MV Tool User's Guide - Rev 1.1 Page 14 of 46 



RW Automation, LLC 

6.2) Scale to fit 
 
Selecting this option makes the following dialog appear: 
 

 
 
 
This is similar to the scale option except the user can select the exact size (in pixels) that 
the image will be scaled to. 
 
When OK is pressed, the image in the topmost child window is scaled per the parameters 
entered into the dialog box and the new scaled image replaces the original image in the 
child window. 
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6.3) Subsample 
 
Selecting this option makes the following dialog appear: 
 

 
 
This is an alternative form of scaling in which the image is scaled down in size by 
subsampling (skipping) pixels at the user selected rates. 
 
When OK is pressed, the image in the topmost child window is subsampled per the 
parameters entered into the dialog box and the new subsampled image replaces the 
original image in the child window. 
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6.4) Rotate 
 
Selecting this option makes the following dialog appear: 
 

 
 
This option allows the user to rotate an image about its center by the specified angle. 
Refer to the MV Lib user’s guide for information regarding image rotation. 
 
When OK is pressed, the image in the topmost child window is rotated per the parameters 
entered into the dialog box and the new rotated image replaces the original image in the 
child window. 
 
 

6.5) Transpose 
 
When this option is selected, the image in the topmost child window is transposed and the 
new transposed image replaces the original image in the child window. 
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6.6) Mirror 
 
Selecting this option makes the following dialog appear: 
 

 
 
When OK is pressed, the image in the topmost child window is mirrored about the axis 
specified by the user. The new mirrored image replaces the original image in the child 
window. 
 
 

6.7) Geometric 
 
Selecting this option makes the following dialog appear: 
 

 
 
Refer to the MV Lib user’s guides for details on geometric transforms. The user may 
define a geometric transform by entering the desired parameters into the dialog box. 
 
When OK is pressed, the image in the topmost child window is transformed according to 
the parameters entered into the dialog box.  The new transformed image replaces the 
original image in the child window. 
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6.8) Linear stretch 
 
When this option is selected, a linear contrast stretch is performed on the image in the 
topmost child window. The new image replaces the original image in the child window. 
 
 

6.9) Equalize 
 
When this option is selected, a histogram equalization is performed on the image in the 
topmost child window. The new image replaces the original image in the child window. 
 
 

6.10) Negate 
 
When this option is selected, a negation is performed on the image in the topmost child 
window. The new image replaces the original image in the child window. 
 
 

6.11) Binary threshold 
 
Selecting this option makes the following dialog appear: 
 

 
 
The user may adjust the threshold via the edit box or the slider and view the binary 
threshold results real-time.  
 
When OK is pressed, the image in the topmost child window is binarized according to the 
threshold entered into the dialog box.  The new binary image replaces the original image 
in the child window. 
 
If cancel is pressed, the image returns to it original state. 
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6.12) Pixel map 
 
Selecting this option makes the following dialog appear: 
 

 
 
The user may manually enter (old pixel, new pixel) data pairs via the edit boxes, or by 
clicking on the map area, the map will change, real-time, as the cursor is moved across 
the map area of the dialog box. 
 
When OK is pressed, the image in the topmost child window is mapped according to the 
pixel map entered into the dialog box.  The newly mapped image replaces the original 
image in the child window. 
 
If cancel is pressed, the image returns to it original state. 
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6.13) Dither 
 
Selecting this option makes the following dialog appear: 
 

 
 
The user selects the size of the dithered image and the type of dithering algorithm. When 
OK is pressed these parameters are used, along with the image in the topmost child 
window, to create a dithered image. The new (binary) dithered image is placed into its 
own child window. The original image is left as-is. 
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6.14) Add noise 
 
This menu item has three sub-menu selections, detailed in the sub-sections below. Refer 
to the MV Lib user’s guide for details of how these noise generator algorithms operate. 
 
 
 
6.14.1) Salt and pepper noise 
 
Selecting this option makes the following dialog appear: 
 

 
 
The user must select the probability of white and dark pixels occurring. When OK is 
pressed, salt and pepper noise is added to the image in the topmost child window. 
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6.14.2) Uniform noise 
 
Selecting this option makes the corresponding dialog appear: 
 

 
 
The user must select the mean and standard deviation of the uniform noise function. 
When OK is pressed, uniform noise is added to the image in the topmost child window. 
 
 
 
6.14.2) Gaussian noise 
 
Selecting this option makes the corresponding dialog appear: 
 

 
 
The user must select the mean and standard deviation of the Gaussian noise function. 
When OK is pressed, Gaussian noise is added to the image in the topmost child window. 
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7) Filter menu 
 
The options in this menu allow the user to perform filtering operations on images.  
 
 

7.1) Average 
 
Selecting this option makes the following dialog appear: 
 

 
 
The user must enter the desired window size of the averaging filter. 
 
Pressing OK will cause the image in the topmost child window to be filtered with the 
averaging filter of the specified size. The original image is replaced with the filtered one. 
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7.2) Median 
 
Selecting this option makes the following dialog appear: 
 

 
 
The user must enter the desired window size of the median filter. 
 
Pressing OK will cause the image in the topmost child window to be filtered with the 
median filter of the specified size. The original image is replaced with the filtered one. 
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7.3) Max 
 
Selecting this option makes the following dialog appear: 
 

 
 
The user must enter the desired window size of the max filter. 
 
Pressing OK will cause the image in the topmost child window to be filtered with the 
max filter of the specified size. The original image is replaced with the filtered one. 
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7.4) Min 
 
Selecting this option makes the following dialog appear: 
 

 
 
The user must enter the desired window size of the min filter. 
 
Pressing OK will cause the image in the topmost child window to be filtered with the min 
filter of the specified size. The original image is replaced with the filtered one. 
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7.5) Small template 
 
This menu option has a sub-menu with three options detailed in the subsections below. 
 
 
 
7.5.1) Sobel magnitude 
 
When this option is selected, a Sobel gradient magnitude filter is run on the image in the 
topmost child window. The original image is replaced with the filtered one. 
 
 
 
7.5.2) Sobel orientation 
 
When this option is selected, a Sobel gradient orientation filter is run on the image in the 
topmost child window. The original image is replaced with the filtered one. 
 
 
 
7.5.3) Laplacian 
 
When this option is selected, a Laplacian filter is run on the image in the topmost child 
window. The original image is replaced with the filtered one. 
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7.6) User-defined template 
 
Selecting this option makes the following dialog appear: 
 

 
 
By changing the filter columns and rows edit boxes, the number of filter coefficient edit 
boxes will change (up to 7x7). The user may also define the type of filtering process to be 
performed (sum of products, gradient magnitude, gradient orientation). Once the filter 
size and operation have been selected, the user must enter the filter coefficients into the 
coefficient edit boxes. 
 
Pressing OK will cause the image in the topmost child window to be filtered with the 
specified filter. The original image is replaced with the filtered one. 
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8) Algebra menu 
 
Selecting any of the image algebra options will cause a dialog box similar to the one 
below to be displayed: 
 

 
 
The user must select an image from the list of currently opened images displayed in the 
dialog. The selected image must be of the same size and type as the image in the topmost 
child window. When OK is pressed, the image is processed according to the menu option 
as described below. 
 

8.1) Add 
 
Selecting this option adds the selected image to the image in the topmost child window. 
The resulting image replaces the one in the topmost child window. 
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8.2) Subtract 
 
Selecting this option subtracts the selected image from the image in the topmost child 
window. The resulting image replaces the one in the topmost child window. 
 
 

8.3) Multiply 
 
Selecting this option multiplies the selected image by the image in the topmost child 
window. The resulting image replaces the one in the topmost child window. 
 
 

8.4) Divide 
 
Selecting this option divides the selected image into the image in the topmost child 
window. The resulting image replaces the one in the topmost child window. 
 
 

8.5) And 
 
Selecting this option logically ANDs the selected image with the image in the topmost 
child window. The resulting image replaces the one in the topmost child window. 
 
 

8.6) Or 
 
Selecting this option logically ORs the selected image with the image in the topmost 
child window. The resulting image replaces the one in the topmost child window. 
 
 

8.7) Xor 
 
Selecting this option logically XORs the selected image with the image in the topmost 
child window. The resulting image replaces the one in the topmost child window. 
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8.8) Max 
 
Each pixel of the selected image is compared to the corresponding pixel in the image in 
the topmost child window. The greater of the two pixels values is chosen for the resulting 
image. The resulting image replaces the one in the topmost child window. 
 
 

8.9) Min 
 
Each pixel of the selected image is compared to the corresponding pixel in the image in 
the topmost child window. The lesser of the two pixels values is chosen for the resulting 
image. The resulting image replaces the one in the topmost child window. 
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9) Fourier menu 
 
2-D Fourier transforms can be performed on images. They can be used to better 
understand the frequency content of an image. 
 
 

9.1) Forward transform 
 
Selecting this option will cause a forward Fourier transform to be run on the image in the 
topmost child window. The Fourier transform of the image replaces the image in the 
child window. As with all complex images, only the real component is displayed in the 
child window. 
 
 

9.2) Inverse transform 
 
Selecting this option will cause an inverse Fourier transform to be run on the image in the 
topmost child window. The Fourier transform of the image replaces the image in the 
child window. As with all complex images, only the real component is displayed in the 
child window. 
 
 

9.3) Magnitude 
 
This option will only work on complex images. Selecting this option will cause the 
magnitude of each complex pixel to be computed for the image in the topmost child 
window. The resulting image then replaces the one in the child image. 
 
 

9.4) Phase 
 
This option will only work on complex images. Selecting this option will cause the phase 
of each complex pixel to be computed for the image in the topmost child window. The 
resulting image then replaces the one in the child image. 
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10) Analysis menu 
 
This menu holds some basic image analysis options. 
 
 

10.1) Statistics 
 
When selected, the image in the topmost child window is analyzed and its statistics are 
presented to the user in a dialog like the example shown below: 
 
 

 
 
 
Note: the histogram is only displayed for binary and 8-bit images. 
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10.2) Scene angle 
 
The user may choose from unidirectional or bidirectional scene angle analysis. In either 
case the image in the topmost child window is analyzed and a dialog like the one in the 
example below is displayed: 
 

 
 
As well, lines are overlaid onto the image in the child window in order to illustrate the 
scene angle found. The image itself is left unchanged. 
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10.3) Projection 
 
Sub-menus allow the user to choose from projection onto the X axis, projection onto the 
Y axis, or projection at an arbitrary angle. In the case of projection onto an arbitrary 
angle, the user must enter the angle in the following dialog: 
 

  
 
In any event, once the type of projection is chosen, the image in the topmost child 
window is projected onto the chosen axis. The resulting projection is displayed in a 
separate window, such as the one shown in the example below: 
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10.4) Profile 
 
When the user selects the profile option, MV Tool is put into the profile state. This state 
is displayed in the status bar. When a user clicks on an image and drags the cursor over 
the image, a line from the starting point to the current cursor point is drawn and updated 
real-time as the cursor is moved. Releasing the cursor causes all image pixels “under” the 
line to be gather and displayed in a separate window. This user-selected 1-D slice of the 
image is the “profile” (see example below): 
 

 
 
Once the profile is complete, MV Tool returns to the normal mode allowing rectangular 
regions of interest to be selected with the cursor. 
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10.5) Perspective plot 
 
Before selecting this option, the user must select a region of interest in the desired image 
window. Once this option is selected, a new window is created and displays the pixels in 
the region of interest as a 3-D “perspective plot”. An example is shown below: 
 

 
 
Note: regions of interest over 50x50 pixels are scaled to a maximum of 50 pixels in either 
dimension. This perspective plot is itself an image and may be saved and loaded just as 
any other image can be. 
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11) Search menu 
 
The search menu is used to allow users to access the normalized correlation search (NCS) 
and fiducial localization functionality of MV Lib. 
 

11.1) Train 
 
Before selecting this function, the user must have already selected a region of interest 
within an image of no more the 256x256 pixels. Once this option is selected, a NCS 
model is trained and held internally. 
 
 

11.2) Search, normalized correlation 
 
In order to use this option, the user must first “train” a model by using the train option. 
Once selected, a search for the previously trained model is conducted on the image in the 
topmost child window. The location of the target found is displayed on the image and the 
coordinates and normalized correlation score are displayed in a dialog box like the 
example shown below: 
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11.3) Search, normalized correlation options 
 
By selecting this option, the following dialog is presented to the user. The parameters 
used to search for a model in an image can then be edited. When OK is pressed, the 
parameters are stored internally and are applied to all subsequent searches (see section 
11.2). 
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11.4) Localize fiducial 
 
Before selecting this option, the user must first select a region of interest in the image that 
is to have a fiducial localized. Once the region of interest has been selected, the user can 
choose to localize the fiducial in X, Y, or Both by selecting the appropriate sub-menu 
option. 
 
Once selected, a search for the fiducial is conducted on the image in the topmost child 
window. The location of the fiducial is displayed on the image and the coordinates and 
normalized auto-convolution scores are displayed in a dialog box like the example shown 
below: 
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12) Blob menu 
 
Binary and watershed segmentation (blob finding) algorithms can be run through this 
menu. 
 

12.1) Binary 
 
Selecting this option will allow the user to run a connectivity analysis on a binary image. 
The user can set parameters to restrict the size and number of blobs found using the 
following dialog box: 
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Once OK is pressed, a connectivity analysis is run on the image in the topmost child 
window, using the user-specified parameters. The result will be a dialog box similar to 
the one shown in the example below: 
 
 

 
 
In addition, the blobs found are highlighted in the child window holding the image. All 
blobs found are shown in red, except the one selected in the above dialog box, which is 
shown in green. By selecting a blob in the list, the user can see where the blob appears in 
the image. The image itself is not changed. 
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12.2) Watershed 
 
Selecting this option will allow the user to run a watershed analysis on a 8-bit image. The 
user can set parameters to restrict the size and number of blobs found using the same 
dialog box as used for connectivity analysis (see section 12.1). 
 
Once OK is pressed, a watershed analysis is run on the image in the topmost child 
window, using the user-specified parameters. The result will be a dialog box similar to 
the one shown in the example below: 
 

 
 
This is the same dialog as used for connectivity analysis (see section 12.1) except that 
some additional information specific to watershed analysis is displayed (refer to MV Lib 
user’s guide). 
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13) Window menu 
 
The Window menu contains four commonly used options for organizing and finding the 
child windows. 
 
 

13.1) Cascade 
 
Selecting this option causes the open child windows to be arranged in “cascade” order. 
 
 

13.2) Tile 
 
Selecting this option causes the open child windows to be arranged in “tiled” order. 
 
 

13.3) Arrange icons 
 
Selecting this option causes the minimized child windows to be arranged at the bottom of 
the main MV Tool window. 
 
 

13.4) Images displayed 
 
All child window titles (image path names) are displayed at the bottom of the menu, with 
a check mark beside the topmost child window. 
 
Selecting one of the listed images will select it and make it the topmost child window. If 
the selected window is minimized, it will be restored as it is brought to the front of the 
window order. 
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14) Help menu 
 
Currently the Help menu has one option, detailed below: 
 

14.1) About MV Tool 
 
Selecting this option causes the following dialog to be displayed, from which the user can 
determine the version of the MV Tool program. 
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